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BMDM Software Release Notes 
 
Version 5.10b3 
 
Bug Fixes 
No longer get Bad data communication status or communication timeout error 
when sending the IP address to an MPM. 
 
Cell voltages were not updating if the Discharge window was exited before 
getting all discharge data. Discharge data extraction now stops if exiting 
Discharge View screen. This allows cell voltages to update immediately. 
 
Password for Check Settings is now the System Setup password. 
 
Discharge Curve timeline now reflects discharge time, not data points. 
 
Enhancements 
Net mask field no longer required for non-IP Address strings. 
 
For 8 and 12 voltage batteries, the voltage is now only displayed to two 
decimal places, not to millivolts. 
 
Wider hysteresis added for color thresholds on Cell Voltage bar graph. 
 
Service location now displays the message "This string needs to be set up" if 
there are no names in the monitor. 
 
Check Settings window now opens when connecting with a Service location. 
 
Cell Memos in Trend reports are now filtered by cell number. 
 
Features 
Extract All Data menu item added to the File menu in Location view. 
 
 
Version 5.10b2 
 
Bug Fix 
Random modem hangup problems have been addressed. 
 
 
Version 5.10 
 
Bug Fixes 
When connected to a BDS controller and saving a string memo, the corrected 
message now appears, "All string memo info in BDS will be over written." 
 
The string number on the String tab in Location Setup now is always saved. 
 
Calibration constants would not send if the Send and Close buttons were 
clicked too soon. The screen now will not close until the calibration 
constants are sent. 
 
Enhancements 
Delete key now deletes a String Memo in Memo view. 
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Modem connect time increased from 30 seconds to 90 seconds. 
 
Password is now disabled when opening a new database. 
 
 
Version 5.00B26 
 
Bug Fix 
Cell Voltages now update in Discharge View during a load test. 
 
 
Version 5.00B24 
 
Bug Fixes 
The calibration factor for test current was previously not sent or saved. 
 
MPM no longer displays a DCM communication error. 
 
 
Version 5.00B23 
 
Bug Fixes 
Change connected Communication status from "hanged up" to "hung up." 
 
DCM number did not advance on Float Alarm tab in Check Settings. 
 
Location view didn't display logging discharge status when controller was 
retrieving data. 
 
Features 
Added the ability to remove cells from the cell list created using Click+Alt. 
You can now remove a cell not wanted in the watch list. 
 
Added support for eight temperature calibration constants for new MPM 
firmware. The software now looks at the firmware version to determine if it 
has eight temperature constants. 
 
 
Version 5.00B22 
 
Bug Fixes 
The History Alarm didn't show the end date/time if the alarm was not reset or 
latched. The date now shows for these alarms. 
 
Log parameter for overall voltage for discharge was not sent during battery 
setup. The log for OV is now in hundreds of millivolts, not in millivolts. 
 
If the last opened database was deleted or moved, the program would error out 
and wouldn't open another database. 
 
The Discharge report showed power as a negative value. 
 
The Discharge Report Summary section showed two OV@30. Changed the second 
OV@30 to ACV@30. 
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The Discharge Summary page showed the wrong temperature probe values. The 
temperature displayed  "32" instead of the true temperature for a one probe 
system. In more than a one probe system, the last reading was always 32. This 
fix only works on discharges polled with this version. Discharges polled with 
previous versions will still show incorrect values. 
 
When viewing Float Voltage History in Location View, current is no longer 
displayed. 
 
 
Version 5.00B21c 
 
Bug Fixes 
When setting the BDS default values, the threshold levels for the alarms were 
not preset like in previous versions. 
 
The BDS configuration number was off by 1 for new strings when selected in 
Location Setup. If Check Setting was done and uploaded, this would set the 
correct configuration number. 
 
Calibrating new databases or calibrating new strings added to existing 
databases no longer overwrites calibration constants. 
 
 
Version 5.00B21b 
 
Bug Fixes 
In Calibration, when calibrating cell voltage, the polling status display was 
one cell number off. 
 
Calibration factors were updating before Enter was pressed. Calibration 
factors now are calculated after Enter is pressed. 
 
The Save As command was corrupting the database if the name entered was the 
same as the open database. Save As no longer allows the currently open 
database name to be used. 
 
Names 20 characters long caused an error message when connecting or polling. 
This no longer occurs. 
 
The backup data base function was not working. When selecting File|Backup 
Database, it was creating an empty file. 
 
Enhancements 
On the Communications Setup window, Force All Strings to Direct Connection 
now filters strings by network or modem connection in the string selection 
box in System Setup View. 
 
Features 
Battery setup now shows a progression bar during download. If an error 
occurs, a message will be displayed. 
 
Location View has two new buttons, Previous String and Next String, to change 
the currently connected string. Also, the Page Up and Page Down buttons now 
change the current string. The Enter key always goes to the next string. 
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Version 5.00B21a 
 
Bug Fixes 
The wrong threshold values were being used for display during discharge. 
During a discharge, the bar graph and parameter text colors now use values 
from the problem discharge thresholds. 
 
The invalid network port error message appeared when saving the Link tab in 
System Status without an entry in the field. New strings now default the port 
number to 502. 
 
When configuring for a network connection in System Setup, if there was no 
netmask, an error message displayed when attempting to save. Because the 
netmask is not always required, new strings now default to 255.255.255.0. 
 
Now can change the password in the Controller in Battery Setup. 
 
Features 
Added the ability to enter a decimal value when calibrating intertier and 
intercell. 
 
Could not get the voltage historical reading from the monitor while connected 
to a string. Added menu item Extract History under the File menu to retrieve 
historical voltage readings. 
 
Enhancements 
Communication time for direct connect and modem was changed from 3 seconds to 
6 seconds to reduce time outs on Check Settings. 
 
False Actual Reading and Measured Value were displayed in the Calibration 
screen (Test Current only). When clicking in the Measured Value field for 
test current, a Measured Value of 30.8 amps was automatically entered. Test 
current is no longer calculated upon entering the field. 
 
Check settings took 1.5 to 2 minutes to get data. Was displaying Comm 
Timeout 1 until data was retrieved. Changed Communication Time for direct 
connect and modem from 3 seconds to 6 seconds. Increasing time value causes 
time outs on check setting to be lessened. 
 
 
Version 5.00B21 
 
Bug Fixes 
When the DB range was set to the last time period, the start and end dates 
were set when this option was selected. After one month, the start and end 
dates didn't update, the last time period was off by one month, and the last 
month's data was not shown in reports. 
 
After a resistance test was performed, the cell voltages would not update 
until you exited the string or switched strings and then reconnected. 
 
Overall Voltage (OV) didn't show discharge alarm level colors in the 
discharge replay summary area. When setting threshold levels to override the 
preset levels in the discharge view screen, the overall voltage field in the 
replay screen didn't alarm (change color) when below the threshold. 
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Extracting Discharge Data from a multistring MPM was saving all data to 
string 1 on the MPM. 
 
The Actual Name in the name error window was incorrect. The name displayed 
was the name from the database, not the hardware. 
 
Discharge View Summary for cells did not show cells below threshold. If, in 
the report section, Auto Select was not set, the summary page did not show 
any cells. 
 
Discharge replay option showed 3 digits instead of 4 for current. The 
component was set for 4 digits, including the sign character (-), causing 
-1600 amps to read -160 amps because the sign took one character. 
 
Overall Voltage and Discharge Current stopped updating during a discharge. If 
a communication error occurred when polling OV/DC, the flag to update them 
got cleared and was never set again. 
 
Features 
All threshold violations now change background color instead of text to make 
the text easier to read. 
 
Enhancements 
Diagnostics load test step duration was too short. This didn't allow enough 
time to measure the reading. 
 
 
Version 5.00B20b 
 
Bug Fixes 
When there was no intercell data present when generating a Summary report 
with Threshold Deviation enabled, a list index out of bounds exception error 
occurred if Intercells was enabled. 
 
The Resistance Test in DCM was not sending the DCM number to the Controller; 
thus, the test was always being performed in DCM 1. GET was starting the test 
again. This was also causing the load module to pull in random relays. 
 
Enhancement 
Program would not run with Spanish OS. Program location now allows directory 
path to be stored at any location. 
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Version 5.00B2 
 
Bug fixes: 
 

- The installation date under system setup will no longer return to an 
invalid date. 

 
- When viewing history records, the overall volts and discharge current 

will no longer update. 
 

- Corrected the value displayed on cells past cell 9 in discharge 
playback mode. Previously, when you clicked on a cell in the discharge 
replay, the field that displays the value is too small. You would have 
thousandths up to cell 9, hundredths from 10 to 99 and tenths from 100 
and above. 

 
- Intertier threshold can not be set for intertiers above intertier 1. 

 
- On the summary report, thresholds in the deviation report no longer 

fail if intercells are enabled. 
 

- The alarm cell number in alarm detail listings for low cell voltage, 
high cell resistance and intercell will now report the correct cell 
number. 

    
 
Version 5.00B19 
 
Not released 
 
Version 5.00B18 
 
Bug fixes: 
 

- The “Hide Alarm Reporting Window” now correctly shows its setting. The 
check box was always showing it selected. 

 
- The selected cell under calibration is now correctly selecting the 

appropriate cell. Previously it was off by one. 
 

- When BDS defaults is selected under battery setup, the total Cell 
number was not shown. 

 
- When entering a field under calibration, the software would calculate 

the current value based on current K factor and A/D counts. This is now 
disabled. 

 
- Can now calibrate temperature. DCM number was not being sent to 

controller. 
 

Enhancement: 
 
- Added the open history button back to the location view screen. 

 
- Selecting tabular or graph preference is now saved to the registry so 

it will remember the settings. 
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Version 5.00B17 
 
Bug fixes: 
 

- Changing the cell thresholds under the discharge playback will now take 
effect as soon as they are entered. Previously, you had to exit the 
screen and then re-enter before seeing the change. 

 
Enhancements: 

 
- Added preference to disable the alarm reports pop up. This selection is 

located under the preference settings. 
 
Version 5.00B16 
 
New Features 
 
The following features have been added for Polling: 
 

- Extracts historic float data, resistance data, and discharge data on 
demand for the entire system or on a per-string basis. 

 
- All remote sites connected via modem can be called on demand for present 

status and alarm events. Can be done for the entire system or on a per-
connection basis. 

 
- Polls all modem strings connected to the same modem with a single phone 

call. 
 
- Can force all connections to a direct connect port. Useful when using a 

service or local computer on a temporary basis. 
 
- A dial prefix can be assigned to the modem port. The prefix does not 

have to be embedded in the database. 
 
- The port number assignment is increased to 16 for modem and direct 

connect. 
 
- Can enable or disable polling on a per string basis. The avoids error 

messages when a system is known to be off-line. 
 
- Communication setup is now stored in the registry, not in the database 

configuration file. 
 
- Communication/ polling status area now gives more detailed information 

about names, connection status and errors. 
 
- Can use two modems simultaneously. This allows polling and remote 

reporting. 
 
The following features have been added for Reports: 
 

- All report generator reports are accessible through the location view 
(string view) screen. 
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- All trend graphs can be printed. 
 
The following features have been added for Alarms: 
 

- All alarms that occurred are viewable in the Alarm Event screen. 
 
- There are now separate alarm event screens for paging, faxing, and 

printing. 
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The following features have been added for the Database: 
 

- The database can be backed up on demand. 
 
The following miscellaneous features have been added: 
 

- Smarter graph and cell layout. 
 
- Tab page view for location view (string view) screen. 
 
- Improved discharge playback. 
 
- The Windows short date format is used for all displayed dates. 

 
Bug Fixes 
 

- The program no longer locks up when polling under Windows NT and XP.  
 
 
 
Version 4.11B8 
 
- Added new configuration for MPM-100 - 1X54X2 . 
 
- Improved float current resolution. 
 
- Discharge multiplier will not affect float current reading now. 
 
Version 4.11B4 
 
New Features 
 
- Added one 1X90X1 MPM-100 configuration for Nicad’s. 
 
Bug Fixes 
 
- Corrected resistance test algorithm for systems reading 4V modules. 
 
- Corrected functionality when using dual modems for dialing and answering 
monitor calls. 
 
Version 4.10B1  
 
New Features 
 
- Now has multi-language support. Current languages supported are English, 
Spanish, Chinese and Korean. 
 
- When entering system setup, a valid password must now be entered. The 
default password is alber. This password only stays active for five minutes. 
 
- Now supports settings for Netmask and Gateway for network setup. 
 
- Added ability to adjust the scaling for all the trend graphs. 
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- Added the ability to support float current readings on the BDS system. This 
does require the new version of the DCM hardware and an optional float 
current transducer. 
 
- Added a feature to allow renumbering of cells in reverse order. This is 
used when cell 1 is the most negative instead of the most positive. 
 
- Local computers can now be set to auto extract data. This will allow Local 
PC's to have the same data as the Central PC. This auto extraction will only 
take place once a day at 10:00 PM.  
 
- Trending feature has been added for intertiers. 
 
- Now supports all functions for intercell readings. This feature does 
require optional hardware. 
 
- Added support for new MPM-100 hardware. This includes the following 
features and configurations: 
 
Features: 
4 additional intertiers. (8 total and may require optional hardware) 
7 additional temperatures. (8 total and may require optional hardware) 
4 float current channels. 
40 additional cell inputs. 
 
Configurations: 
1X13X2  
2X13X2 
3X13X2 
4X13X2 
1X26X1 
2X26X1 
3X26X1 
1X41X1 
2X41X1 
1X10X1 
2X10X1 
3X10X1 
4X10X1 
1X80X1 
1X92X1 
1X96X1 
1X97X1 
1X58X2 
1X15X8 
2X15X8 
1X25X1 
2X25X1 
3X25X1 
4X25X1 
1X4X6 
2X4X6 
3X4X6 
4X4X6 
3X24X2 
4X24X2 
2X20X1 
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3X20X1 
4X20X1 
1X23X2 
2X23X2 
3X23X2 
4X23X2 
 
 
Enhancements 
 
- When names do not match when connecting, the error message will have a 
button called Ignore. This allows the names to be changed by resending 
battery setup. 
 
- No longer gets name errors when connecting to other strings using the 
select string button via the network. 
 
-The current record on the Historical Events screen no longer changes during 
auto polling. 
 
- Now displays the name of the filename when performing a firmware upgrade. 
 
- The cell data pop-up box is now cleared when exiting the trend screen. 
 
- Improved auto polling time for checking discharge data. 
 
 - Duplicate discharge records no longer are created in database. 
 
- The diagnostic or calibration screens are now disabled during a discharge 
or resistance test.  
 
- If the page was unsuccessful after three attempts, a "page fail" status is 
displayed in Historical Events. 
 
- Now supports an internal network card for BDS series monitors. 
 
- The Alpha pager now reattempts up to three times if a paging error occurs. 
 
- Extended the string name character count on the string status screen to 
match that under system setup. 
 
- Now disables the start resistance test button while retrieving data. 
 
- When adding new strings, the Historical log, Resistance test, Load test 
intervals and float alarms are now set to disabled as the default. 
 
- A cancel button now exists when performing firmware upgrades. 
 
- Added String ID, Customer name, Current string status and Monitor status to 
Alarm print out 
 
- When performing a check settings upload, the Telco MUX enable/disable is 
now transferred to the database. 
 
- When starting the software, the Access driver is automatically configured 
to IDDA3532.dll. If this was changed, the program restores it to the original 
setting when exiting the program. 
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- Changed the existing time-out of 60 seconds to 90 seconds on the PC modem. 
This helps with international connections which can take a long time. 
 
- Added DCM comm error to the summary screen on the status screen. 
  
- Increased the station phone number by one more character. 
  
- Changed some of the firmware upgrade reboot messages to be more 
descriptive. 
 
- Added String ID, Current string status and Monitor status to Alpha pager. 
  
- When "Set BDS Defaults" is selected under battery setup, it now defines the 
discharge thresholds. 
 
- All the cells and overall volts will not go to yellow when a discharge is 
in progress. When system is in discharge, the violation threshold to control 
the bar graph colors now follows the settings defined for the discharge 
thresholds.  
 
- Under battery setup on the discharge tab, a disable button under the report 
options has been added. When selected, it stops the controller or MPM from 
calling out during a discharge event. Also, changed the name and function of 
the remote reporting selection at the top left section of the discharge tab. 
This is now an enable/disable function. This button now enables or disables 
the discharge logging function. 
  
 
Bug Fixes 
 
- Changing the total cell number under battery setup now changes the display 
to reflect the correct amount of cells. 
 
- Corrected the min and max values on the discharge current curves. They were 
reversed. 
 
- Corrected the OV@30 and ACV@30 readings on the discharge summary screen. 
 
- Corrected miscellaneous faxing problems. 
 
- The total number of alarms listed at the top of the current alarm screen is 
now correct. Is was off by 1. 
  
- The control outputs on the BDS controller no longer lose their setup. This 
occurred when battery setup was sent from any string other than string 1. 
 
- Software no longer has to be restarted after changing preferences. This had 
to be done to have the column selection changes take effect under the 
Historical Events screen. 
 
- When the monitor reports an alarm, it no longer enters the information to 
the wrong string in the historical events. 
 
- On an MPM configuration 1X60X2, if you changed the total cell number to 59 
under the battery setup, it would change back to 60 after changing the 
communication link. This no longer occurs. 
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- The cell voltages now continue to update after getting historical readings. 
Previously, the cell voltages would freeze and stop updating. 
 
- When viewing historical resistance readings, the screen now properly 
updates when changing to another screen. 
 
- Corrected miscellaneous typographical errors. 
 
- If a Local computer is direct polling and set to numeric page, the PC no 
longer stops polling if the page is not successful. 
 
- The numeric pager no longer operates in a continuous loop. Sometimes it 
will continue to hang-up and redial, then send another page. 
 
- When receiving alarm calls for a warning, the cell numbers displayed in the 
alarm pop up dialog are now correct. 
 
- Now sends a fax or a page when software is setup to auto extract data. 
 
- The printer setup dialog no longer has the 10,000 page setting for page 
selection. 
 
 
Version 3.30F11 
 
Enhancements: 
 
- Added the ability to add one more character in the station phone under 
System Setup. 
 
Bug Fixes: 
 
- Print button removed from the String View, Resistance, and Discharge View 
screens. 
 
- When the program is closed and reopened, the value for high cell voltage 
warning now remains at the set value. 
 
 
Version 3.30B11 
 
New Features: 
 
- If there are intertiers assigned and you view the intercell resistance 
readings, the intertier resistance bar graphs change to red based on the 
intercell resistance alarm threshold. Additionally, if an intertier is on the 
second row of readings, it will go up through the upper row of readings. When 
this happens, you can no longer click on the cell directly above the 
intertier. 
 
 
Version 3.30B10 
 
New Features: 
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- BDS-256 series now has a high cell voltage warning threshold under the 
Battery Setup. When this parameter is violated, it will turn the cell bar 
graph to blue. 
 
- Software now supports one string of 20 NiCad cells for MPM-100 
configurations. 
 
Enhancements: 
 
- If the database has a lot of discharge data for a specific string, it can 
take a long time to display the initial list of discharges when selecting the 
Discharge button. During this time, it appears the machine is locked up. This 
amount of time is dependent on how many and how long the discharges are, as 
well as the speed of the machine. This time delay also occurs when selecting 
another discharge from the list. This delay will no longer occur at these 
points. It will now delay during the processing of the data if entering the 
actual playback for a particular discharge. The speed of the machine can 
drastically enhance this time. 
 
- The Setup Menu item on the String View screen is now only be enabled while 
connected to string 1 of the controller. When connected to strings 2 to 8 on 
the controller, this menu item is disabled. 
 
- While auto polling and the modems are unable to handshake and establish a 
connection, the software now attempts a second time before logging a 
unknown/inactive status. 
 
- On String View screen, if System Status is "Discharging," "Logging 
discharge data," or "R-test in Progress," buttons for Discharge View and Load 
Test View are disabled. Their menu items are also disabled 
 
- On multiple alarm events on the same controller, the pop up alarm dialog 
now shows alarm events on second alarm event. 
 
- In the Battery Setup | General tab,  a selection to enable the use of a 
Telco multiplexer was added. This is only settable from string 1 on 
controllers. MPM does not require this feature because a DIP switch is used 
to identify it. 
 
- If communications fails after three attempts during auto polling, a monitor 
status of Comm Error is logged to the Status screen and Historical Events 
screen. 
 
- When connected to a BDS series controller, a second type of check settings 
was implemented for retrieving  data from the controller for diagnostic 
purposes. This is accessed by holding the CTRL key while selecting Check 
Settings. The advantage of this is that data is not cleared out of the 
controller by DCM data. To use this function, you must first get controller 
data (CTRL+Check Settings) before selecting just Check Setting. This is only 
used for a diagnostic tool. 
 
- The discharge status has changed for the Status screen. There is now a 
"discharging" status to indicate discharge in progress and a second status, 
"discharge occurred," to indicate a completion of a status. Both of these 
status conditions were also added to the Summary screen. 
 
Bug Fixes: 
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Discharge data no longer gets corrupted if extracting data during a 
discharge. 
 
 
Version 3.20B42 
 
New Features: 
 
- Networking is now supported on TCP/IP networks. Monitors must have the 
optional network interface for this function to work. 
 
- BDS series now supports monitoring of up to 16 digital dry contacts and can 
control up to 8 control outputs. These outputs can be configured to energize 
on any parameter alarm violation. The controller must have the optional 
Digital I/O board to take advantage of this new feature. 
 
- BDS Series  now has definable discharge thresholds for cell voltage, 
overall voltage, and maximum allowable time for discharge. If any of these 
thresholds are violated, the system can call and report to the central 
computer. 
 
Enhancements: 
 
-  Some modem manufacturers do not work reliably. It appears modems with chip 
sets manufactured by Conexant do not work; however, modems with chip sets by 
3Com work well. Our recommendation is to use a US Robotics modem manufactured 
by 3Com for best results. 
 
-  The data extraction algorithm has been changed in functionality. Before, 
it was possible to extract and clear data from the hardware without it 
actually being stored in the database. Data will not be cleared from hardware 
until it has successfully been stored to the database. Also, if 
communications is corrupted, multiple attempts of retrieving data will be 
tried before displaying the "Not responding" status. 
 
- The String View screen title bar now displays the string, battery, and 
location name being viewed. 
 
- The "Discharge in Progress" status now flashes during a discharge.  
 
- The Normal/Test menu selection has been removed from the Setup menu on the 
String View screen on BDS configurations. The system will always operate in 
Normal mode, which allows data transfer from DCMs to the controller during a 
discharge. This reduces the overall data transfer time after a discharge. 
 
- Now, when a computer is configured for a direct or a network connected 
Local or Central computer, all the reporting options function. For example, 
when the computer continuously polls the monitor and identifies a problem, 
the computer can automatically page, sound an alarm, and fax or print an 
alarm report. 
 
- Software now qualifies the proper extension of the firmware upgrade file 
before performing the upgrade.  
 
MPM-100  = filename.mp1 
Controller = filename.ctl 
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DCM = filename.dcm 
 
The file name includes the version number. For example, VER113.MPM is Version 
1.13 for the MPM-100. At the time of software installation, the latest file 
also is loaded to a new subdirectory called "upgrade" under the 
c:\ProgramFiles\Alber\MPMManager directory. Future firmware releases will 
automatically extract this directory. 
 
-  You can now begin names with numbers for Location, Battery and String 
names. 
 
- The String Status Summary display now has "Unknown" added. 
 
- When setting up a new system, it is no longer necessary to disconnect the 
fiber optics before sending the battery setup. A separate command now treats 
Calibration and Battery Setup as two different things. 
 
- On MPMs, you now can set the discharge alarm to a latch mode under Battery 
Setup. Previously, all discharge alarms were non-latching.  
 
- The Alarm Detail on the Historical Events screen now updates with the alarm 
detail during auto polling. Previously, this only updated when a site called 
the computer. 
 
- The Status screen now always shows the latest polled status. In earlier 
versions, it only indicated the last updated status after connecting 
manually. 
 
- During auto polling, the software now shows an alarm pop up screen and 
reports the problem. Additionally, the system executes any of the reporting 
functions defined on the reporting tab under System Setup. 
 
- The discharge status has changed for the Status screen. There is now a 
"discharging" status to indicate discharge in progress, and  a "discharge 
occurred" to indicate the completion of a status. Both of these status 
conditions were also added to the Summary screen. 
 
- The String Status on the main Status screen now indicates a DCM COMM error. 
This, however, will not be displayed in the Historical Events log in this 
release. 
 
- Two column titles in the Discharge Summary listing were changed. The 
headings were changed from OV@30 to OV@30S and ACV@30 to Avg CV@30S to better 
describe the functions. 
 
- The Auto Call Out and Report descriptions under the General, Float Alarm, 
and Discharge tabs were changed to Remote Reporting, since all these enables 
are for enabling call out and providing status to a remote computer, not 
local status. 
 
- The IP address for network connections can now be sent to the MPM from 
Battery Setup. There is a new button on the General tab for MPM 
configurations. This feature can only be used with MPMs that have the 
embedded network interface. Units that use the external interface must still 
use hyper terminal. 
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- On the Status and Historical Events screens, the following status were 
added to the Monitor Status column. 
 
Network error - Cannot find network node or initialization error. 
Data corrupt - Identifies corrupted data within the monitor. 
Modem error - Modem cannot be initialized. 
No dial tone - No dial tone is detected when calling. 
Modem Busy - Busy signal is detected when calling. 
DCM Comm Error - Communication error between controller and DCMs. 
 
-On the Historical Events screen, the following status were added to the 
Alarm Detail column. 
 
Pager busy - Busy signal when paging. 
Paging error - Connection failed or cannot initialize modem. 
 
- The default sorting on the String Status screen is now set to the String ID 
column. 
 
- The Alarm Detail is now displayed in the Historical Events log for a 
warning condition. 
 
- A built in backup feature was added to help prevent short-term data loss. 
However, this should not replace periodic backups of the database that 
physically copy data from the hard drive. This new backup feature will not 
protect the database against catastrophic hardware failures. 
 
- A backup of the current working database now is compressed to a WinZip 
compatible file at midnight of each day. This file is appended with the 
number 1 and the extension changed to zip. This continues for three days in a 
row, appending each backup with a different number - 1, 2, or 3. On the 
fourth day, the oldest backup is overwritten, starting with 1.  
 
- On the first day of each month, another backup is created, with the number 
0 appended to the file name. On the first of each month, this file is 
overwritten. 
 
-Under the File menu, a menu selection called "Open Backup" was added to 
allow the backup files to be opened. 
 
- If the Historical Events screen was maximized and you performed a print 
function from this screen, the computer appeared locked up. This was because 
the "Always on top" selection was made under the View menu. This caused the 
Historical screen to remain on top, but it was disabled because control was 
handed over to the report viewer. This menu selection has been removed, and 
now this screen minimizes before print preview displays. 
 
- It is now not possible to set the Discharge Trigger Mode to Current unless 
a current channel has been first assigned to a DCM. 
 
- The Flash memory diagnostic in the MPM now allows selection of a file that 
was uploaded to Flash to be compared for integrity. This same diagnostic was 
also implemented in the BDS controller. 
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- When calibrating the system, you now must press the Enter key to calculate 
the calibration factor. Previously, a new calibration factor would calculate 
just by clicking in another measured value field, possibly sending false 
information to the DCMs. 
 
- The cells displayed on the bar graph now take up the width of the screen, 
rather than leaving a blank area at the end of the bar graph area. This is 
only true for systems of fewer than 64 cells. For example, a 40 module system 
now occupies the entire display area and does not leave any blank area at the 
end. 
 
- You now have the ability to define the control outputs to a specific 
string. Previously, they were always triggered from String 1 parameters. 
 
- The string status "DCM Comm Error" is now highest priority. 
 
- Resistance Test and Historical Readings can now be recorded many times in a 
single day on demand. When opening readings from the database, the time 
appears next to the date. 
 
- Scaling on the resistance screen was changed to allow better presentation 
of the bar graphs. Previous versions had too fine resolution, indicating a 
huge disparity between readings. Now, the readings look more the same, unless 
one is actually bad. 
 
- The program no longer copies the MPM-DB3.MDB database to the MPM3.MDB file 
to keep the database alias the same. It now automatically changes the alias 
name to any database file that is opened, and also remembers what database 
was last opened. This helps prevent overwriting databases when working with 
multiple databases. 
 
- An empty database called "db320.bmd" was added under the database 
directory. This is used to create a new empty database by selecting File|New. 
 
- On new installations of the software, a list of all standard configurations 
is now available from the Monitor Configuration drop down list on the String 
System Setup tab. This works in conjunction with a new "Set BDS Defaults 
Values" button on the Battery Setup | General tab on the String View screen. 
Selecting this button automatically defines the hardware parameters Cells, 
LS/D, R/LS, RLLS, SS#, and Cell Voltage on the Parameters tab, the Cell 
Voltage, Overall Voltage and Temperature Alarm values on the Float Alarms 
tab, and the Total Cell Number on the General tab to default values.  
 
- While viewing bar graph data (voltages or resistances), you can now select 
multiple cells into one pop up box to view tabular data. This is particularly 
useful when performing scheduled discharges and you want to see the tabular 
data value of failing cells. This table can also be sorted to easily identify 
the worst cells. Cells are inserted to a pop up box by holding the ALT key 
while selecting cells with the mouse. 
 
- Self-Test diagnostics for BDS series controllers now have a diagnostic for 
checking the modem to see if a dial tone is present.  
 
Bug Fixes: 
 
- The View|Trend|Current menu function now works while viewing internal 
resistance readings. 
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- It was possible to see an access violation while viewing, exiting or 
deleting records in the Historical Events screen. This has been corrected. 
 
- In previous versions, when changing screens while viewing resistance 
measurements, the intertier values did not clear. If the new string you 
switched to did not measure intertiers, previous string values were still 
displayed. 
 
-  Previously, if the DCM address diagnostic was being used, it would not 
turn off when exiting. Diagnostics now properly exit from the DCM Comm Error 
tab. 
 
- It was possible to get an access violation during completion of a system 
setup. Other functions are now disabled while in the Setup screens. This 
prevents illegally accessing multiple tables within the database. 
 
- When viewing the cell voltages, occasionally the values did not get 
updated, and appeared locked up. This was most apparent after leaving 
Calibration or Diagnostics. Communication was fixed to eliminate missed 
commands. The system was being left in a stop scan mode under certain 
functions and would miss the command to release this mode. 
 
- The ALT+C keystroke was defined for two functions under Diagnostics - Close 
and Alarm Contacts. The Alarm Contacts was changed to ALT+A. 
 
- You can now get resistance readings from DCMs other than the first DCM when 
performing a diagnostic resistance test. 
 
- In computers with NT operating systems, the alarm sound now shuts off after 
clearing the pop up alarm dialog.  
 
- Computers with NT operating systems could not page successfully. This has 
been corrected. 
 
- During auto polling, it was possible for an error message "Invalid Pointer" 
to appear and cause the polling sequence to stop. This has been corrected. 
One of the visible effects of this change is that the polling interval for 
direct polling is now 15 seconds instead of 10 seconds. 
 
- When transferring data via the Upload command during initial setup of an 
MPM database, the Discharge Current Level and Log Current Value did not get 
transferred until the second attempt. This now happens on the first attempt. 
 
- Previously, if report selection was made under the BDS  Battery Setup, and 
maintenance selection was made, the report selection disappeared after 
exiting back to Battery Setup. This has been corrected. 
 
- Cell Voltage Average is now displayed on the String View screen for MPM 
configurations. 
 
- The menu items "Reboot Firmware" and Upgrade Firmware" no longer become 
inactive after a DCM firmware upgrade. 


